Physics E-1ax, Fall 2014

Experiment 3

Experiment 3: Force
•

Learning Goals
After you finish this lab, you will be able to:
1. Use Logger Pro to analyze video and calculate position, velocity, and acceleration.
2. Find your center of mass by balancing yourself on two force plates.
3. Measure the normal force exerted on an object (you) using a force plate.
4. Use your video measurements of position (y) to find the y-component of your
acceleration, ay.
5. Compare the net force with ma to see how Newton’s Second Law holds for a
complicated object (you) in a complicated motion (jumping).

Introduction: Please read all of this BEFORE you come to lab.
•

The particle model for a complex object: use the center of mass!
In this lab, you'll explore Newtonian mechanics of an extended, non-rigid object: your
own body. Whenever your center of mass accelerates, it must be due to a net external
force; conversely, any time there is a net external force on your body, it will result in
motion of your center of mass. This motion can be extremely non-obvious, because your
center of mass can move as a result of a shift in body position rather than an overall
movement of your entire body.
Recall Newton’s 2nd Law for a particle or simple object: the sum of the forces on the
object is equal to its mass multiplied by its acceleration. At this point in the course,
you’ve used this fact many times to solve physics problems. Typically, we proceed by
drawing the free-body diagram of an object and adding up all the forces on it and then
using Newton’s 2nd Law to equate the total force to the object’s mass times its
acceleration.
But what about an extended object or system, which can have many moving parts? For an
extended object the net force is given by the the sum of the external forces on the system.
But which acceleration are we talking about? Remember how we defined the concept of
center of mass. Our definition of center of mass ensures that Newton’s Second Law will
hold if we treat a complex object with a total mass Mtotal as a particle of mass Mtotal
located at the center of mass. That is:
The sum of all external forces on a system is equal to the total mass of the system
multiplied by the acceleration of the system's center of mass:
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= M totalaCM
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This “particle model” represents an extraordinary simplification: we can model a
complicated object like the human body as a simple point particle! But first we’ll need to
think about where the center of mass of a person is.
•

Jumping
Whether you are standing or jumping, the only external forces acting on your body are
the normal force from the ground and gravity. How can you jump? Raising your center of
mass into the air seems like it would require gravity to diminish or the normal force to
grow. Why would either of these happen?
The one thing we know for sure is that gravity isn’t changing. Therefore, it must be that
the normal force from the ground increases as you jump, propelling you into the air.
Because you push off harder on the ground with your legs, by Newton’s 3rd Law, the
ground must also be pressing harder on you.
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Experiment 3: Lab Activity
•

Follow along in this lab activity. Wherever you see a question highlighted in red, be sure
to answer that question, or paste in some data, or a graph, or whatever is being asked.
Your lab report will be incomplete if any of these questions remains unanswered.

Who are you? Take a picture of your lab group with Photo Both and paste it below along
with your names.

•

Tutorial:
Before setting up the equipment, work through the Logger Pro tutorial number 12:
Video Analysis (in the Tutorials folder under Experiments).

•

Materials:
Force plate: The force plate is simply a flat plate that
can measure the normal force exerted by it.
By itself, the force plate is basically like a bathroom
scale. But when you use it to do data collection with
Logger Pro, it can show you the normal force as a
function of time, which is quite powerful.
The reading given by the force plate is the y-component
(upward component) of the normal force that the plate exerts on you while you are
standing on it. So this reading is positive if the force plate is pushing up on you, but
negative if the plate is pulling down on you. (The latter would be quite rare—unless you
are wearing sticky shoes, the reading would just go to zero when your feet are no longer
in contact with the force plate.)
There is a switch on the force plate that toggles between the two ranges: between –200 N
and +800 N, or between –800 N and +3500 N. We’ll use the latter setting; with this
range, the force plate reading has an uncertainty of 1 N.
The force plate is pretty sturdy, but it can be permanently damaged if you apply very
large forces to it (greater than 5000 N). So you should feel free to stand or jump on it, but
don’t actively attempt to destroy it, because you might succeed.
In addition, for this lab you’ll also have a digital video camera on a tripod, a meter stick
to measure distances, a long board that you can lie on to measure your center of mass,
and some stickers that you can use to mark your center of mass.

•

Finding your center of mass
3

Physics E-1ax, Fall 2014

Experiment 3

For this part, you’ll have to work together with your neighboring lab group. Each pair of
lab groups has a long board, two force plates, some tape/stickers, and a meter stick. You
will need to devise a procedure for finding the center of mass for at least one of your
group members. (Hint: start by putting the board across the two force plates and zeroing
both of them.)
A good way to think about this is to imagine: what would the two force plates read if
your center of mass were exactly in between them? Is there any way you can put your
center of mass so it’s between the two plates?
Write your explicit procedure for locating your center of mass here:

Everybody is encouraged to locate his or her CM and mark it with a bright sticker;
however, at least one person from each group of 3 must do it.
Where is your center of mass located? (Report it in cm up from your feet):

•

Moving your arms
This section of the lab involves working with your original group of 2-3 people, so you
can split back up into your regular groups at this point. Also you can remove the long
board from both force plates and place it against the wall. You won’t need it again.
Open up a new window in Logger Pro. Zero the force plate (from the “Experiment”
menu). Click the Collect button and see what happens. Push on the force plate while it is
collecting. It will collect data for 10 seconds; you’ll see the trace appear on the graph. If
you ever need a do-over, just click on the Collect button again and take another 10
seconds of data.
Zero the force plate again, and then have one member of your group stand on the force
plate with arms down at his or her sides. Start collecting data, and then have the person
who is standing on the force plate quickly raise their arms over their heads so that they
are pointing straight up, hold them there for 3 seconds, and then quickly bring them back
down again.

Paste the graph of the normal force vs time here:

Qualitatively, what features do you observe in the graph?

Is the reading on the force plate the same at the end as at the beginning? Why or why not?
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Why does the normal force change as you move your arms? Explain your observations in
terms of what you know about Newton's Laws.

Make a qualitative sketch of the height of the person's center of mass as a function of time
during the 10 seconds. Take a picture of it and include it here.

In the “Latest” data set, create a new calculated column called “Net Force” which gives
the y-component of the net force on you. Remember, the force plate only reads the
normal force. You’ll want to create a “parameter” for your mass m and another
parameter for the gravitational acceleration g (with appropriate units). How can you
determine your mass?
Make a graph of the NET force as a function of time and paste that graph here. (If you did
this correctly, the net force should start and end close to zero…)

•

Jump!
In this part, you will have the opportunity to explore the physics of a standing jump. We
encourage everybody to take a turn jumping on the force plate (you may opt out if you
wish), though the full analysis should only be done for one jumper per group. You will
record a standing vertical jump, using both the force plate and the video camera.
Open a new window in Logger Pro. Go to the “Insert” menu and select “Video Capture.”
If the settings are not visible, click “Show Settings.” For the “Video Input” select
ZR830. The video resolution should be set to 720 x 480. Set the “Video Compression”
to H.264 SD.
Then click on “Options” and set the following options.
- Video Capture Mode: Video Capture Synchronized with Data Collection
- Duration: 10 seconds
- Make sure "Time-Lapse Capture" is not checked.
- Capture File Name Starts With: MovieCapture
- Finally, click on the Camera Settings button. In the Compression tab, under Motion,
Frames per Second, insert 30, then click OK. (Don’t worry if it tells you that the
compression mode is not the default.) Click OK again.
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Zero the force plate with nobody standing on it.
Have one of your group members stand on the force plate facing the camera. Make sure
their center of mass label is clearly visible. Another group member should stand next to
them holding a one-meter stick. You will use the whole meter stick to set the distance
calibration for the video. Make sure you can see the entire meter stick, the person’s feet
on the force plate, and the person’s center of mass throughout the entire jump.
When you are ready to start filming, click Start Capture. Both the camera and the force
plate will begin collecting and recording. (If this doesn’t happen, go back to the
supplemental material and make sure the Video Capture settings are correct.) The capture
should run automatically for 10 seconds and then stop.
During the 10 seconds, jump up as high as you can and land back on the force plate.
Repeat as necessary, until you get a clean data run (person jumped straight up/down, did
not bump into things, did not fall off the force place, etc.)
To continue analyzing your data, you will need to synchronize the movie to the force
plate data. Although both are collected at the same time, they are on slightly different
clocks, so they are not really synchronized to begin with.
Look carefully at the graph of the force plate as a function of time. Find the point during
the your jump when your feet just lose contact with the force plate—we will call this the
moment of takeoff. (Hint: what happens to the normal force if two objects are no longer
in contact?)
In the lower-right corner of the movie window, click the

button.

A synchronization dialog box will open. First, click in the graph on the moment of
takeoff. You should see the time corresponding to your click appear in the dialog box.
Next, play through the video frame by frame until you find the very first frame where
your feet leave the force plate. The time corresponding to this frame will also appear in
the synchronization dialog box.
Click OK in the dialog box to sync the movie.
Once the movie is synchronized with the force data, you can use the “Examine” button in
the graph and the movie will automatically show the frame corresponding to the time you
are examining. You can also set up a replay control (Analyze → Replay...) to watch the
force plate trace and the movie at the same time, at whatever speed you like.
•

Forces involved in jumping
In the “Latest” data set, create a new calculated column called “Net Force” which gives
the y-component of the net force on you. Remember, the force plate only reads the
normal force. You’ll want to create a “parameter” for your mass m and another
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parameter for the gravitational acceleration g (with appropriate units). How can you
determine your mass?
Make a graph of the NET force as a function of time and paste that graph here. (If you did
this correctly, the net force should start and end close to zero…)

On the net force graph, determine the time at which each of the following events occurs.
Mark each point on the graph with a Text Annotation (from the “Insert” menu). (Careful!
some of these are trickier than they look!)
1: The start of the crouch preceding the jump
2: The jumper’s center of mass reaches its maximum downward velocity during the crouch
3: The lowest point of the crouch
4: The jumper’s center of mass reaches its maximum upward velocity
5: The moment of takeoff
6: The highest point of the jump
7: The jumper’s feet touch the ground at the end of the jump
Paste a copy of the force versus time (with annotations) graph here:

•

How high did you jump?

How long were you in the air? Determine this from the force graph. You will need to zoom in
on the graph to measure it accurately.
Flight time tflight =

If we assume that the takeoff and landing occur at the same y-position, we can actually
calculate the maximum height reached during the jump from tflight alone (and g).
Find an algebraic expression for the height of the jump in terms of tflight and g. Make sure
you show your work, and check your answer with a TF before moving on.

From the flight time, calculate the height of your jump.
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Now use Video Analysis to track the motion of your center of mass (conveniently
marked with a sticker in the movie). Use the meter stick to set the scale. You don’t have
to mark the entire duration of the video; start marking each frame just before you start to
go down into your crouch and stop a little bit after you touch down at the end of the
jump.
Display on your graph both the force and the CM position simultaneously. Paste a copy
of your graph (showing both Force and Y vs Time) here:
Graph:

From the video analysis, how far did your center of mass move from the moment of takeoff
to the top of your jump?

Compare the results of the two methods of measuring the jump height. If they are way
off, see if you can figure out why.
•

Newton’s Second Law: does the “particle model” hold?
In the “Video Analysis” data set, create a new calculated column called “ma” that
contains your mass times the y-acceleration of your center of mass. You’ll need to use a
calculus function for the acceleration: ay is equal to secondDerivative(“Y”, “Time”)

Create a new graph that has both “Net Force” and “ma” on the y-axis, and Time on the xaxis. Zoom in on the region where both Net Force and ma are visible and paste a copy of
it here:

What do you observe about the plots? What can you conclude?

•

Conclusion

What is the most important thing you learned in lab today?

What aspect of the lab was the most confusing to you today?
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